
 

 

WIPL-D Pro CAD: What is New in 2025 Release?

The 2025 release of WIPL-D Pro CAD introduces major 
enhancements, powerful new features, and a wide range 
of improvements designed to boost performance and 
provide greater flexibility to users. 

1. Significant program environment upgrades: 

a. The new version of the program is a 64-bit 

application 

b. Working with multiple monitors is improved 

c. Flickering has been removed 

2. Significant improvements to the program's operation: 

a. Domain Decomposition Solver can now be 

invoked directly from CAD 

b. Current Generators excitation is introduced in 

CAD 

c. Improved current calculations 

d. Access to new Type of Basis Functions, Physical 

Optics (PO), from CAD 

e. PEC, PMC, and Half-Space Green Functions are 

introduced in CAD 

f. Working with STL files has been improved 

g. Scattered field calculation is introduced when 

specifying Near Field results 

h. Pro Checker is introduced to check the 

correctness of IWP files 

i. Fast Calculation of the radiation pattern 

j. New ways to define custom excitation waves and 

far field directions of interest 

k. Run as Avoided with Extrapolation 

l. Other program's operation enhancements 

3. Cosite (antenna systems coupling) analysis has been 

implemented: 

a. Automatically created Ellipsoids surround the 

area of interest around antenna systems and 

loadings, for the reduction of the number of 

unknowns 

b. Options to perform “Exact solution” and “Friis 

model solution” 

c. Different excitation types: Generator/Port, Field 

Generator, and Current Generator 

4. Geometry modeling improvements: 

a. Segmented helix has been introduced 

b. New Split Face option 

c. Other geometry modeling improvements 

5. Meshing of the structure is revised for simulation 

smoothness and user comfort: 

a. The mesh process has been accelerated 

significantly 

b. Coaxial port and waveguide port mesh and mesh 

for Periodic Boundaries have been improved 

c. Mesh quality is greatly improved for highly 

curved, small surfaces 

d. Mesh is optimized to prevent unnecessary re-

meshing by monitoring changes in model settings 

6. New possibilities when working with Symbol list: 

a. Supporting symbols definition expression up to 

4096 characters 

b. Hints for the symbols table 

c. New mathematical functions 

d. Find & Replace mechanism 

7. More flexibility for materials definitions and 

handling: 

a. Distributed loadings now apply to all metal 

bodies and appear in the Domain table 

b. Domain assignment via εr_imag, μr_imag, or via 

Loss Tangent (e_tan(δ), m_tan(δ)) 

c. Metallic Pattern attribute 

d. After Boolean operations, new regions are now 

filled with vacuum instead of PEC 

8. Additional improvements, enhancements, and bug 

fixes 

 

Enhanced Post-Processing for Smarter Insights! 

The upgraded WIPL-G post-processing application offers 

advanced analysis and visualization of simulation 

results. Check out the full release notes. 

https://wipl-d.com/wp-content/uploads/2025/11/What_is_New_in_WIPLG_v21.pdf


 

 

1. Significant Program Environment 
Upgrades 

This release brings a more stable software suite as we put 
in great effort to prevent bottlenecks and implement 
improvements suggested by our customers. 

a) The New Version of The Program Is a 64-Bit 
Application 

The new version of the program is a 64-bit application, 
which brings speed and reliable memory management 
compared to the previous 32-bit version. Extremely large 
models are smoothly previewed, saved, and meshed. 

b) Working with Multiple Monitors is Improved 

Advanced users will benefit when using multiple 
monitors, as in the new version, working in such an 
environment has been improved for increased user 
comfort. 

c) Flickering has been Removed 

Flickering of the Project Tree, Subtree, Symbol table, and 
Preview flickering during rendering, model rotations, and 
other preview operations have been removed. 

2. Significant Improvements to the 
Program's Operation 

There are numerous operation enhancements that have 
been introduced to simplify the interoperability of the 
programs comprising WIPL-D suite, minimize the chance 
of error, improve stability and robustness, and open new 
possibilities to boost productivity. 

a) Domain Decomposition Solver can now be 
Invoked Directly from CAD 

The new version supports a direct link to the Domain 
Decomposition Solver (DDS). The program is invoked by 
clicking on an icon located in the Simulation/Run group 
on the ribbon. 

 
Fig. 1. How to start DDS from CAD. 

Users can set the solver parameters for the initial run or 
subsequently add more iterations, as illustrated in the 
previous figure. 

b) Current Generators Excitation is introduced in CAD 

Current sources, i.e., generators, have now been 
introduced in CAD. They are set up similarly, as in WIPL-D 
Pro. 

 
Fig. 2. Current generators in CAD. 

The users fill in the necessary data in the menu, which 
opens by clicking on an icon located in Source/Load Tab 
Excitation group on the ribbon, as illustrated in the 
previous figure. 

Then, the users should select Add to add the current 
generator settings or select an existing table row to edit 
or remove it. The table is presented in the next figure. 

For Regular simulation, only one excitation, which 
corresponds to the first list entry, is considered. More 
than one excitation can only be used for Cosite simulation 
Friis model. Likewise, current generators cannot be mixed 
with other excitation types; it is only allowed for Cosite 
simulation Friis model (see Section 3). 

 
Fig. 3. Adding a current generator to the table. 

Users should enter the path to the file where the current 
data has been defined. The source location within the 
model and its orientation can be adjusted – the current 
source can be translated and/or rotated according to the 
users’ preferences by entering required data in the 
Current Generators table, as shown in the next figure. 



 

 

 
Fig. 4. Adjusting location and orientation for the 

imported current generator. 

Where symmetry planes are defined, images of imported 
CSs can be included when calculating the radiation 
pattern, see the next figure for setting up current 
calculation (Home > Output Results > Currents). 

c) Improved Current Calculations 

Adaptive setting of the number of points as in WIPL-D Pro 
for Low/Medium/High current density. 

An equivalent current source can be created from this 
menu by checking Create current sources field. 

 
Fig. 5. Specifying density of points for current 

calculation. 

d) Access to new Type of Basis Functions, Physical 
Optics (PO), from CAD 

A novel type of Basis Functions has been introduced, 
Physical Optics (PO). This type can be selected for metallic 
structures only when one of the Scattering operation 
modes is active. They are most suitable for large 
scattering problems where approximate yet very 
accurate solution is required. 

e) PEC, PMC and Half-Space Green Functions are 
Introduced in CAD 

Another enhancement introduced with the analogy with 
Pro are the three new Green’s functions: PEC, PMC and 
Half-Space. They can be specified by clicking on Symmetry 
icon from Home/Define group. 

 
Fig. 6. Specifying Green’s function calculation . 

For user comfort, the hints on how to fill in the field to 

use a particular Green’s function are included in the 

body of the Symmetry menu, as shown in the previous 

figure. 



 

 

f) Working with STL Files has been Improved 

Decimation and Meshing capabilities from WIPL-D Pro STL 
Editor have been adopted. The program automatically 
recognizes that STL file has been opened. Then the Mesh 
Settings window looks like shown in the next figure. Three 
meshing methods, each with its specific Decimation style, 
are available for selection. 

 
Fig. 7. Mesh settings for STL files – predefined 

settings. 

 
Fig. 8. Mesh settings for STL files – user defined 

settings. 

Users can override the default decimation settings for 
each of the three methods by checking the Decimation 
field and opening the Decimation setting menu that 
becomes active. 

More details on meshing methods and decimation 
settings can be found in WIPL-D STL Editor Manual. 

g) Scattered Field Calculation is Introduced when 
Specifying Near Field Results 

When specifying the output results, in Near Field table for 
both Scattering modes (Monostatic and Bistatic) users 
can now select to output the scattered field. This means 
that after the simulation finishes, the data for the near 
scattered field only (not the superposition of direct and 
scattered field) is available for display. This option is 
selected by choosing the Scattered field only option from 
the Near Field settings, as illustrated in the following 
figure. 

 
Fig. 9. Choosing Scattered Near Field calculation. 



 

 

h) Pro Checker is Introduced to Check the Correctness 
of IWP Files 

Pro Checker is introduced in CAD in order to check the 
correctness of IWP (mesh, i.e. simulation ready) file. The 
checking is executed by clicking Check Sim Ready File on 
Simulation/Mesh group as presented in the next figure. 

 
Fig. 10. Starting Check IWP file command. 

i) Fast Calculation of Radiation Pattern 

A novel method of radiation pattern calculation has been 
developed. The method can be selected by checking 
Configure/Advanced Modeling/Fast Radiation Pattern 
evaluation option. 

Users are encouraged to use it regularly, and perhaps for 
mission-critical projects, verify the results by comparison 
with the results obtained with classic method. 

j) New Ways to Define Custom Excitation Waves and 
Far Field Directions of Interest 

A new type of file format, .nwc, has been introduced which 
could be used with Big (Farfield) Data Calculation, where a 
large number of calculation directions and excitation waves 
are defined using direction grids. An example is provided in 
the next figure. 

      
 Fig. 11. The .nwc file. 

The interpretation of the data listed in the file are as 
follows: 

In the first line, a total number of 9 direction grids is 
specified, where only 6 provide data for the simulation, 4 
for excitation, and 2 for far field calculations. Nine 
direction grid line containing grid specification follow, the 
format is as described for .nwa files. Finally, line 11 
presents that 1st, 4th, 7th, and 9th direction grid lines will 
be used to define the excitation grid, while line 12 
specifies that lines 6 and 8 describe grids that will be used 
for far field calculations. More details on the 
specifications of .nwc file can be found in the User’s 
Manual. 

k) Run as Avoided with Extrapolation 

Sometimes it is beneficial to have a rough estimate about 
the values of an important parameter as precise 
determination of the parameter would require significant 
computer resources. One illustrative example could be the 
RCS calculation of a target at a high frequency where the 
number of unknowns is prohibitive, as it would take a larger 
amount of memory than available. 

To provide user with a reasonably accurate approximate 
result in such cases, a new computing option called Run as 
Avoided with Extrapolation has been introduced. Basic idea 
behind the new option is to extrapolate current 
distribution calculated on operating frequency to higher 
frequency and calculate RCS based on the extrapolated 
distribution without performing usual MoM calculation at 
higher frequency. The extrapolated current densities can 
be combined with Physical Optics (PO) calculation and 
weighted so that PO weight increases as the desired 
frequency departs from the frequency where exact 
solution has been calculated.  

The calculations are invoked from Simulation > Run > As 
Avoided With > Run as Avoided with Extrapolation menu 
where averaging can be switched on/off by 
checking/unchecking the corresponding box. The 
frequency at which the extrapolated solution is required 
should be entered in the field Frequency and by clicking OK 
extrapolated solution calculation starts. 

The avoided regime for calculations is set up automatically. 
Previously described method of fast Radiation Pattern 
calculation is also automatically invoked when using Run as 
Avoided with Extrapolation. At this point, the extrapolated 
calculation works with scattering modes, monostatic and 
bistatic only, and (A)symmetry, PEC/PMC and Rotation 
(PEC) setting cannot be used. 



 

 

l) Other Program's Operation Enhancements 

Numerous additional improvements have been 
implemented in the latest release, such as: 

a. Improved robustness for Avoided Run which now 
supports projects with Field Generators. Also, 
Frequency Parallel and Frequency Dependent 
simulations are supported in Avoided mode. 

b. Local settings parameters are more robust now. 

c. Validation is significantly accelerated and a warning is 
introduced for Validation of projects with symmetry 
planes. For the Frequency Selective Surface (FSS) in 
the picture below, where Booleans were conducted 
through Validate, current model read-in time is 0.5 
min while previously it was 10 min. 

 
Fig. 12. Frequency Selective Surface (FSS) where 

validation has been accelerated around twenty times . 

d. Assembly structure export is enabled. 

e. Optimization of projects with waveguide load is more 
robust. 

f. De-embedding changes made from graph viewer, 
WIPLG, are adopted for subsequent model simulation 
(useful for optimization e.g. scanned antenna arrays). 

3. Cosite (Antenna Systems Coupling) 
Analysis has been Implemented 

This novel program feature brings the possibility to 
explore the potential of interference between various 
systems located on large platforms by calculating the 
mutual coupling between the antennas/antenna systems, 
in the wide frequency range. Each antenna system may, 
of course, comprise a number of antennas i.e. an array. A 
typical example includes several antennas on a drone, as 
illustrated in the following figures where three of the 
antennas are presented. Electrically large scenario should 

be judiciously simplified to be simulated in real time and 
with available computing resources without sacrificing 
accuracy. 

The RF Cosite Simulation Settings becomes active when 
pressing the Cosite icon on the Simulation tab. 

 
Fig. 13. Cosite simulation icon is located at Simulation 

tab. 

The following menu appears, allowing the user to control 
the approximation process. 

 
Fig. 14. Cosite simulation settings. 

 



 

 

a) Automatically Created Ellipsoids Surround the 
Area of Interest around Antenna Systems and 

Loadings, for Reduction of Number of 
Unknowns 

The first step in simplification of an electrically large 
structure is to define a volume centered around each 
antenna system (or loadings for passive antennas). The 
volumes around the antenna/loading are regarded as 
significant for subsequent EM simulation and are defined 
through specification of the ellipsoids that encompass the 
antenna. 

A platform with three antennas and the corresponding 
ellipsoids is presented in the next picture. 

 
Fig. 15. Example of ellipsoids created around 

antennas. 

Ellipsoid radius can be expressed in electrical 
(wavelengths) or geometrical (length) units. Dimensions 
of the ellipsoids are set up through a, b and c radius which 
can be made equal for all the ellipsoids in the structure. 
Alternatively, each ellipsoid might have a particular set of 
parameters which are set up in a table Ellipsoids that pops 
up after pressing User Defined button. The appearance of 
the table is presented Fig. 15. 

 
Fig. 16. Settings for ellipsoids radii can vary from one 

ellipsoid to another. 

Starting from specified ellipsoids, the user can opt for one 
of the ways to reduce the number of unknowns. The 
options are available from the Action submenu. 

 
Fig. 17. Three options to set Cosite simulations . 

The option Delete will delete the parts of the scenario not 
included in the ellipsoids. 

 
Fig. 18. Option Delete leaves only parts of the 

structure encircled by ellipsoids. 

The Set Reference frequency is used to reduce the 
reference frequency on the parts outside the ellipsoids. 

 
Fig. 19. Option Set Reference Frequency analyzes the 

whole structure, but the area not encircled by 
ellipsoids is meshed for lower reference frequency. 



 

 

Wire Grid option creates wires in the areas outside of the 
ellipsoids, that provide current flow instead of bilinear 
plates. This option, as previous one, provides significant 
acceleration hance the size of the MoM model is reduced 
a number of times but should be used with caution to 
maintain model accuracy. 

 

Fig. 20. Option Wire Grid creates wires instead of 
bilinear plates outside of the ellipsoids that surrounds 

antenna systems. 

Finally, by choosing None, the user will choose to keep the 
scenario as it is which practically means to replicate the 
exact solution (no reduction in the number of unknowns). 

 
Fig. 21. Option None analyzes the whole structure 

without any approximation – Exact solution. 

b) Options to Perform "Exact solution" and "Friis 
Model Solution" 

When selecting the Exact formulation, the user calculates 
the coupling between the antennas directly from EM 
simulation.  

Alternatively, the approximative method can be used 
based on the utilization of the Friis formula. In this 
method, the program uses full 3D simulation to calculate 
the antenna gains along the direct paths between each 
antenna pair and uses these values to replace 
corresponding values in the Friis formula. This approach 
is particularly useful when one should combine the EM 
simulation results obtained for the antenna which has the 
3D model available with antenna having only measured 
data or data from data sheets available. The latter 
antennas can be represented with corresponding Field or 
Current generators. 

Friis formulation allows deletion of so-called inactive 
ellipsoids, i.e. while calculation radiation from one 
antenna system to another the feature deletes geometry 
inside all other ellipsoids besides currently active one 
with currently active antenna system. This feature, used 
with caution, also reduces the size of MoM problem and 
speeds up simulation. 

c) Different Excitation Types: Generator/Port, Field 
Generator and Current Generator 

The antenna connection, mentioned previously, can take 
several forms such as Generator/Port, Field Generator 
and Current Generator. Generators and ports are 
required to define any type of antenna modeled in 
WIPL-D suite, while field and current generators allow for 
the use of measured or simulated data. These different 
types of antenna connections can be combined as 
needed, and multiple instances can be used within a 
single project. 

4. Geometry Modeling Improvements 

a) Segmented Helix has been Introduced 

Segmented helix (a helix which is broken into segments) 
has been introduced to make the Sweep mechanism pass 
more easily and consequently to obtain higher quality 
mesh. Specifications of the helix is invoked by pressing 
the Helix button on Construct Reflector/Helix group. 



 

 

 
Fig. 22. Helix settings in new version – Segmented 

helix has been added. 

The Helix Settings window opens where users can choose 
between Smooth and Segmented helix design. For 
Segmented designs, users can specify the number of 
segments per turn. The example of the smooth and 
segmented 5-turn helix is shown in the next figure. 

 
Fig. 23. Differences between Smooth and Segmented 

helix. 

b) New Split Face option 

This option introduced in the latest software release 
forces division of a face along parametric lines of the 
geometric surface. This is a powerful method to force 
finer meshing for particular faces. 

The option is invoked by selecting a face of interest, 
clicking the right mouse button and then choosing Split by 
Parameter, or from menu Modify > Alter > Split Face. 

 
Fig. 24. Complex surface before Split Face command.  

The following menu appears which should be filled in with 
numbers of division lines along u and v parameters. 

 
Fig. 25. Specifying division along each parameter.  

After the desired division has been set and the menu 
released by clicking OK, the selected face is split into 
smaller pieces, as shown in the next picture. 

 
Fig. 26. Complex surface after Split Face command.  



 

 

c) Other Geometry Modeling Improvements 

The other geometry modeling improvements include: 

a. Improved user experience when performing the 
Wrap operation. 

b. Copy Layer for imported models from WIPL-D Pro 
(IWP files) works much smoother in a new version. 
Sometimes, Parasolid fails to perform Copy Layer for 
such bodies, so more robust operation is invoked in 
this particular case which includes procedure from 
WIPL-D Pro where IWP is native format. 

c. Copy layer is now maximally robust for all body 
topologies. The algorithm preprocesses surfaces in 
several ways making it possible for the operation to 
execute. 

d. Boolean operations were accelerated with 
performing more efficient check for possible 
geometry faults. 

5. Meshing of the Structure is Revised for 
Simulation Smoothness and User 

Comfort 

Meshing is considered a crucial step in using the program, 
and constant emphasis is placed on improvements. 

a) The Mesh Process has been Accelerated 
Significantly 

Meshing phase is accelerated many times for some 
models. 

For example, for the model of absorber shown in the next 
picture the whole procedure now takes ~40 sec compared 
with ~7.5 min before. 

 
Fig. 27. Meshing a piece of absorber has been 

accelerated more than 10 times.  

One of the models showed a huge acceleration, it used 

to take few hours, now it takes around ten minutes, etc. 

b) Coaxial Port and Waveguide Port Mesh and 
Mesh for Periodic Boundaries have been 

Improved 

The mesh quality and correctness are higher as several 
bugs were fixed for certain situations related to ports, and 
PBC structures. 

c) Mesh Quality is Greatly Improved for Highly Curved 
Small Surfaces 

In the next figures an airplane model is shown. The plane 
model has parts with very small radius of curvature.  

The airplane model is therefore not ideally suited for CAD 
modeling and EM simulation. In such cases, original mesh 
algorithm tends to produce inadequate and uneven mesh 
which might cause numerical errors or slow convergence. 

 
Fig. 28. Meshing of an airplane with parts having very 

small radius of curvature. 

The following figure shows significant mesh quality 
improvement with a new algorithm implemented for 
some surface elements. The left side shows mesh 
produced with improved algorithm, while the right side 
shows the same area meshed with original algorithm. As 
can be seen, the original mesh struggles to maintain high 
quality factor on some surfaces, giving many narrow and 
dense faces.  



 

 

 

 

 

 
Fig. 29. The mesh resulting from Improved ( left) vs. 

old (right) meshing algorithm. 

d) Mesh is Optimized to Prevent Unnecessary 
Re-meshing by Monitoring Changes in Model 

Settings 

Model changes that are not supposed to trigger mesh are 
monitored to avoid remeshing. These include changing 
output results settings, automatic edging, and much 
more. 

6. New Possibilities when Working with 
Symbol List 

Many actions have been put in place to make working 
with the Symbol list more comfortable and flexible. 

a) Supporting Symbols Definition Expression up to 
4096 Characters  

To offer users greater flexibility, the Symbol list now 
supports symbols definition expression with up to 4096 
characters. 

b) Hints for Symbols Table  

In the new version, several hints on how to use some 
features are provided while hovering over the list 
heading. The information provided is displayed in the 
next picture. 

 
Fig. 30. Hovering above the Symbol list brings Hints 

about Symbol list essentials.  

c) New Mathematical Functions 

New mathematical functions sinpi(), cospi(), and sqrt(), 
have been introduced. 



 

 

 
Fig. 31. New mathematical functions sinpi(), cospi(), 

and sqrt(). 

sinpi(), cospi(), are common trigonometric functions with 
arguments in brackets automatically multiplied by π, as 
illustrated in the previous figure. Sqrt() is a common 
square root function that was previously entered through 
power function (as ()^0.5). 

d) Find & Replace Mechanism 

When the Symbols List is viewed in text box mode, Ctrl+F 
launches the Find & Replace dialog (the same holds for 
History List). 

 

Fig. 32. Find/Replace can be used if the text editor is 
invoked for the Symbol (and History) list.  

7. More Flexibility for Materials Definitions 
and Handling 

Several additions have been made related to material 
definitions and handling complex situations where 
material assignments should be resolved. 

a) Distributed Loadings now Apply to All Metal 
Bodies and Appear in the Domain Table 

When defining distributed loadings, it can be 
automatically applicable to all metallic surfaces, PEC 
domain, without the necessity to apply it on each surface 
separately. 

All distributed loadings are also listed in a table for 
domains i.e., materials, so all data about material 
properties, losses, etc., is available in one place. 

b) Domain Assignment via εr_imag, μr_imag, or via 
Loss Tangent (e_tan(δ), m_tan(δ)) 

In addition to defining the real and imaginary parts of the 
dielectric permittivity or permeability, in general, the 
material can now be defined by choosing the appropriate 
Loss Tangent. The option is set from menu Configure > 
Dialog Options > Domains. 

c) Metallic Pattern Attribute 

This attribute can be defined on selected entities after 
right mouse click and selected Set Metallic Pattern or 
from menu Modify/Set Properties/Material Properties.  

 

Fig. 33. Setting up the Metallic Pattern attribute 

This setting keeps selected surfaces metallic after 
Boolean and any geometry operations, which is very 
useful for printed structures. Users don’t have to worry if 
metallic parts will change their material properties while 
creating the model. 



 

 

d) After Boolean operations, New Regions are now 
Filled with Vacuum instead of PEC 

In the latest software version, after Boolean operations 
are performed, newly created regions are filled with 
vacuum, not with PEC as before. This is more natural and 
avoids errors in region domains during Booleans, 
Validation etc. 

8. Additional Improvements, 
Enhancements, and Bug Fixes 

a. Average Mesh Q factor is calculated and displayed 
after the meshing process is finished. Once the 
simulation is done, the mesh quality factor value is 
written in the OWP file. 

b. Coinciding plates are now automatically recognized 
during the meshing procedure and are consolidated. 

c. The import of WIPL-D Pro CAD models and the import 
of WIPL-D Pro models have been improved.  

d. Multiple occurrences of geometry instances have 
been resolved and import accelerated for standard 
formats (STEP, IGS, etc.) 

e. Improved consistency of numbering of 
generators/ports in Preview for (A)Symmetry 
projects. 

f. Consistency of numbering of generators/ports during 
the Multiple Copy operation has been made more 
user-friendly. 

g. Resetting the cutting planes (Y, Y and Z) to its original 
position is available 

h. New modes of running from the command line: 

o sr - silent run, does not open CAD GUI, preview, 
project tree… 

o sm - silent mesh, does not open CAD GUI, 
preview, project tree… 

o fsr  - full silent run, does not open CAD GUI, 
preview, project tree... Does not show solver 
window (wipler.exe) 

i. Undo/Redo novelties: 

o Undo/Redo All has been introduced, enabling 
improved navigation through list of commands. 

o Switching quickly between Undo/Redo is no 
longer causing crash. 

j. Multiple bug fixes are introduced. 


